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1. Introduction to Web Services

Web services let applications share data, and—more powerfully—invoke capabilities from other applications without regard to how those applications were built, what operating system or platform they run on, and what devices are used to access them. Although Web services remain independent of each other, they can loosely link themselves into a collaborating group that performs a particular task.

Broadly speaking, a Web Service is simply an application delivered as a service that can be integrated with other Web Services using Internet standards. In other words, it's a URL-addressable resource that programmatically returns information to clients who want to use it. One important feature of Web Services is that clients don't need to know how a service is implemented.

Like components, Web Services represent black-box functionality that can be reused without worrying about how the service is implemented. Web Services provide well-defined interfaces, called contracts, that describe the services provided. Developers can assemble applications using a combination of remote services, local services, and custom code. For example, a company might assemble an online store using the Microsoft Passport service to authenticate users, a third-party personalization service to adapt Web pages to each user's preferences, a credit-card processing service, a sales tax service, package-tracking services from each shipping company, an in-house catalog service that connects to the company's internal inventory management applications, and a bit of custom code to make sure that their store stands out from the crowd.

Figure shows a model that illustrates how Web Services can be linked to create distributed Web applications.
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Web services are invoked over the Internet by means of industry-standard protocols including SOAP; XML; and Universal Description, Discovery, and Integration (UDDI). They are defined through public standards organizations such as the World Wide Web Consortium (W3C).

Technically a Web Service is making a remote method call (RPC) where underlying transport is HTTP (internet).

The methods are defined in WSDL using XML, and the message is transported over HTTP in XML too using SOAP protocol.

The implementer implements web service using technology such as

.NET or Java publishes its interface (WSDL) in UDDI (IBM, Microsoft),

The user discovers web service (WSDL), and makes a call to the appropriate

Method/function.

XML Web Services Overview

An XML Web service is a programmable entity that provides a particular element of functionality, such as application logic, and is accessible to any number of potentially disparate systems using ubiquitous Internet standards, such as XML and HTTP. XML Web services depend heavily upon the broad acceptance of XML and other Internet standards to create an infrastructure that supports application interoperability at a level that solves many of the problems that previously hindered such attempts.

An XML Web service can be used either internally by a single application or exposed externally over the Internet for use by any number of applications. Because it is accessible through a standard interface, an XML Web service allows heterogeneous systems to work together as a single web of computation.

Instead of pursuing the generic capabilities of code portability, XML Web services provide a viable solution for enabling data and system interoperability. XML Web services use XML-based messaging as a fundamental means of data communication to help bridge the differences that exist between systems that use incongruent component models, operating systems, and programming languages. Developers can create applications that weave together XML Web services from a variety of sources in much the same way that developers traditionally use components when creating a distributed application.

One of the core characteristics of an XML Web service is the high degree of abstraction that exists between the implementation and consumption of a service. By using XML-based messaging as the mechanism by which the service is created and accessed, both the XML Web service client and the XML Web service provider are freed from needing any knowledge of each other beyond inputs, outputs and location.

.

XML Web services Infrastructure
One of the primary advantages of the XML Web services architecture is that it allows programs written in different languages on different platforms to communicate with each other in a standards-based way.

XML Web services enable the exchange of data and the remote invocation of application logic using XML messaging to move data through firewalls and between heterogeneous systems. Although remote access of data and application logic is not a new concept, doing so in a loosely coupled fashion is. The only assumption between the XML Web service client and the XML Web service is that recipients will understand the messages they receive. As a result, programs written in any language, using any component model, and running on any operating system can access XML Web services.

XML Web services must be agnostic regarding the choice of operating system, object model and programming language to succeed in the heterogeneity of the Web. Also, for XML Web services to enjoy the same widespread adoption as other Web-based technologies, they must be: 

Loosely Coupled: Two systems are considered loosely coupled if the only mandate imposed on both systems is to understand the aforementioned self-describing, text-based messages. Tightly coupled systems, on the other hand, impose a significant amount of customized overhead to enable communication and require a greater understanding between the systems. 

· Ubiquitous Communication: It is unlikely anyone will build an operating system now or in the near future that will not incorporate the ability to connect to the Internet, therefore providing a ubiquitous communication channel. As such, the ability to connect almost any system or device to the Internet will ensure such systems and devices are universally available to any other system or device connected to the Internet. 

· Universal Data Format: By adopting existing, open standards over proprietary, closed-loop communication methods, any system supporting the same open standards is capable of understanding XML Web services. Utilizing self-describing, text-based messages that XML Web services and their clients can share without the need to know what constitutes each underlying systems enables communication between autonomous and disparate systems. XML Web services achieve this capability using XML. 

XML Web services employ an infrastructure that provides the following: a discovery mechanism to locate XML Web services, a service description for defining how to use those services, and standard wire formats with which to communicate.

	Infrastructure Piece
	Role

	XML Web Services Directories
	XML Web services directories provide a central location to locate XML Web services provided by other organizations. XML Web services directories such as a UDDI registry fulfill this role. XML Web service clients may or may not need to reference an XML Web service's directory.

	XML Web Service Discovery
	XML Web service discovery is the process of locating, or discovering, one or more related documents that describe a particular XML Web service using the Web Services Description Language (WSDL). The DISCO specification defines an algorithm for locating service descriptions. If XML Web service clients know the location of the service description, they can bypass the discovery process.

	XML Web Service Description
	To understand how to interact with a particular XML Web service, it is necessary to provide a service description that defines what interactions the XML Web service supports. XML Web service clients must know how to interact with an XML Web service before they can use it.

	XML Web Service Wire Formats
	To enable universal communication, XML Web services communicate using open wire formats, which are protocols understandable by any system capable of supporting the most common Web standards. SOAP is the key protocol for XML Web service communication.
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XML Web Services Directories

Like any other resource on the Internet, it would be virtually impossible to find a particular XML Web service without some means by which to search for it. XML Web services directories provide central locations where XML Web service providers can publish information about their available XML Web services. Such directories may even be XML Web services themselves, accessible programmatically and providing search results in response to queries from potential XML Web service clients. It may be necessary to use an XML Web services directory to locate an organization that provides an XML Web service for a particular purpose, or to determine what XML Web services a particular organization provides.

The UDDI (Universal Description, Discovery and Integration) specifications define a standard way to publish and discover information about XML Web services. The XML schemas associated with UDDI define four types of information that would enable a developer to use a published XML Web service. These are: business information, service information, binding information, and information about specifications for services.

As a core component of the UDDI project, the UDDI Business Registry allows businesses to programmatically locate information about XML Web services exposed by other organizations. Developers can use the UDDI Business Registry to locate discovery documents and service descriptions.

XML Web Service Discovery:
XML Web service discovery is the process of locating, or discovering, one or more related documents that describe a particular XML Web service using the Web Services Description Language (WSDL). It is through the discovery process that XML Web service clients learn that an XML Web service exists and where to find the XML Web service's description document.

A published .disco file, which is an XML document that contains links to other resources that describe the XML Web service, enables programmatic discovery of an XML Web service. The following shows an example of the structure of a discovery document:

<?xml version="1.0" ?>

<disco: discovery  xmlns:disco="http://schemas.xmlsoap.org/disco"

xmlns:wsdl="http://schemas.xmlsoap.org/disco/wsdl">

      <wsdl:contractRef ref="http://MyWebServer/UserName.asmx?WSDL"/>

</disco:discovery>

However, a Web site that implements an XML Web service need not support discovery. Either another site could be responsible for describing the service, such as an XML Web services directory. Alternatively, there may not be a public means of finding the service, such as when you create the service for private use.

XML Web Service Description

The XML Web services infrastructure is founded on communication via XML-based messages that comply with a published service description. The service description is an XML document written in an XML grammar called WSDL (Web Services Description Language) that defines the format of messages the XML Web service understands. The service description serves as an agreement that defines the behavior of an XML Web service and instructs potential clients in how to interact with it. The behavior of an XML Web service is determined by messaging patterns that the service defines and supports. These patterns conceptually dictate what the service consumer can expect to happen when a properly formatted message is submitted to the XML Web service.

For example, the request/response pattern associated with a remote procedure call (RPC)-style service would define which SOAP message schema to use for invoking a particular method. This pattern would also define the format that the ensuing response SOAP message will follow.

Another example of a messaging pattern represents unidirectional interactions. This pattern is employed when a one-way communication is to take place. In this situation, the sender will not receive any messages from the XML Web service, including fault messages. A caveat to this is when the one-way communication is established using a protocol that is traditionally request/response, where a fault message may be returned.

The schemas that define the SOAP message formats can be defined internally to the actual service description or, they can be defined externally and imported into service description.

In addition to message format definitions and messaging patterns, the service description optionally contains the address that is associated with each XML Web service entry point. The format of this address will be appropriate to the protocol used to access the service, such as a URL for HTTP or an e-mail address for SMTP.

XML Web Service Wire Formats:
Binary protocols such as DCOM consist of a method request layer riding on top of a proprietary communication protocol. Such protocols are not conducive to creating universally available XML Web services. However, this does not preclude you from using such protocols in an XML Web service scenario, but the drawback of using them is that such protocols depend on the specific architectures of their underlying systems and therefore limit the spectrum of potential clients.

Alternatively, you can construct XML Web services to work with one or more open protocols, such as a combination of HTTP and SOAP. As you would expect, the infrastructure required to support different protocols will vary.

XML Web services are not limited to providing remote procedure call (RPC) access. They can also be built to exchange structured information, such as purchase orders and invoices, and can be used to automate and connect internal and external business processes.

HTTP-GET and HTTP-POST

HTTP-GET and HTTP-POST are standard protocols that use HTTP (Hypertext Transfer Protocol) verbs for the encoding and passing of parameters as name/value pairs, along with the associated request semantics. Each consists of a series of HTTP request headers that among other things define what the client is requesting from the server, which responds with a series of HTTP response headers and the requested data if successful.

HTTP-GET passes its parameters in the form of urlencoded text using the MIME type application/x-www-form-urlencoded, which is appended to the URL of the server handling the request. Urlencoding is a form of character encoding that ensures the passed parameters consist of conforming text, such as encoding a space as %20. The appended parameters are also referred to as a query string.

Similar to HTTP-GET, HTTP-POST parameters are also urlencoded. However, instead of being passed as part of the URL, the name/value pairs are passed inside the actual HTTP request message.

SOAP

SOAP is a simple, lightweight XML-based protocol for exchanging structured and type information on the Web. The overall design goal of SOAP is to keep it as simple as possible, and to provide a minimum of functionality. The protocol defines a messaging framework that contains no application or transport semantics. As a result, the protocol is modular and very extensible.

By traveling over standard transport protocols, SOAP is able to leverage the existing open architecture of the Internet and gain easy acceptance by any arbitrary system capable of supporting the most basic Internet standards. You could view the infrastructure required to support a SOAP-compliant XML Web service as rather simplistic, yet powerful, since it adds relatively little to the existing infrastructure of the Internet and still facilitates universal access to the services built with SOAP.

The SOAP protocol specification consists of four main parts. The first part defines a mandatory extensible envelope for encapsulating data. The SOAP envelope defines a SOAP message and is the basic unit of exchange between SOAP message processors. This is the only mandatory part of the specification.

The second part of the SOAP protocol specification defines optional data encoding rules for representing application-defined data types and directed graphs, and a uniform model for serializing non-syntactic data models.

The third part defines an RPC-style (request/response) message exchange pattern. Each SOAP message is a one-way transmission. Although SOAP's roots are in RPC, it is not limited to being a request/response mechanism. XML Web services often combine SOAP messages to implement such patterns, but SOAP does not mandate a message exchange pattern and this part of the specification is also optional.

The fourth part of the specification defines a binding between SOAP and HTTP. However, this part is also optional. You can use SOAP in combination with any transport protocol or mechanism that is able to transport the SOAP envelope, including SMTP, FTP or even a floppy disk.

Example 1 SOAP Message Embedded in HTTP Request
POST /StockQuote HTTP/1.1
Host: www.stockquoteserver.com
Content-Type: text/xml; charset="utf-8"
Content-Length: nnnn
SOAPAction: "Some-URI"

<SOAP-ENV:Envelope
  xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/"
  SOAP-ENV:encodingStyle="http://schemas.xmlsoap.org/soap/encoding/">
   <SOAP-ENV:Body>
       <m:GetLastTradePrice xmlns:m="Some-URI">
           <symbol>DIS</symbol>
       </m:GetLastTradePrice>
   </SOAP-ENV:Body>
</SOAP-ENV:Envelope>
8.Creating XML web service using visual C#.net

Visual Studio.Net provides an ASP.NET Web Service project template to help us create XML Web services in Visual Basic and Visual C#.

To create an ASP.NET Web Service Project
1. On the File menu, point to New, and then click Project.

2. In the New Project dialog box, select the Visual C# Projects folder.

3. Click the ASP.NET Web Service icon.

4. Enter the address of the Web server on which we will develop the XML Web service and specify TempConvert1 as the directory name, such as "http://MyServer/TempConvert1". By default, the project uses our local machine, "http://localhost".

5. Click OK to create the project.

Visual Studio automatically creates the necessary files and includes the needed references to support an XML Web service. When we create an XML Web service project in Visual Studio, we see the Component Designer for Service1.asmx.

Implementing the XML Web Service

The next step is to write the code to implement the functionality of the XML Web service that clients will access. For XML Web services created in Visual Studio, a hidden code-behind file associated with the XML Web service's .asmx file that Visual Studio created for us contains this code.

To add an XML Web service method
1. Double-click the Component Designer's design surface to view the code-behind file.

2. In the code-behind file, locate the code for the Service1 class declaration. Replace the System.Web.Services.WebService attribute code with the following code (shown in bold) before the class declaration:

// C#

[System.Web.Services.WebService(
Namespace="XmlWebServices",
Description="A temperature conversion service.")]
Attaching the WebService attribute to a Public class makes it possible for us to include additional information about the XML Web service, such as a namespace for the XML Web service and a description of the XML Web service. The description property of this attribute is included in the Service help page.

In the Service1 class, we add the following code to declare the ConvertTemperature function:

// C#

[WebMethod(Description="This method converts a temperature in " +

"degrees Fahrenheit to a temperature in degrees Celsius.")]

public double ConvertTemperature(double dFahrenheit)

{

return ((dFahrenheit - 32) * 5) / 9;

}

Attaching the WebMethod attribute to a Public method exposes that method as part of the XML Web service. The description property of this attribute is included in the Service help page and the Service method help page. Right-click Service1.asmx in Solution Explorer and then click Set as Start Page on the shortcut menu.

3. Save the solution.

Deploying the XML Web Service

To make our XML Web service available to others, we must deploy it to a Web server that is accessible to the clients . To deploy the XML Web service to a server other than the development server, we can either add a Web Setup project or copy the required files to the destination server.

To deploy the XML Web service using a Web Setup project
1. On the File menu, point to Add Project, and then click New Project.

2. Select the Setup and Deployment Projects folder, and then click Web Setup Project.

3. In the Name box, type TempConvert1WebSetup, and then click OK.

4. In the left pane of the File System Editor, select Web Application Folder.

5. In Solution Explorer, right-click TempConvert1WebSetup, point to Add, and then click Project Output.

6. In the Add Project Output Group dialog box, select Content Files, Primary output and Debug Symbols.

· The Content Files group consists of the following files for the XML Web service: Service1.asmx, Global.asax, and Web.config.

· The Primary output group consists of the project DLL, TempConvert1.dll, and its dependencies.

· The Debug Symbols group consists of the project PDB file, TempConvert1.pdb.

7. Click OK.

8. In Solution Explorer, right-click the TempConvert1WebSetup project, and then on the shortcut menu, click Build.

This creates a Windows Installer file in the local project directory. Executing this file installs the Web application.

To deploy the XML Web service by copying the project

1. In Solution Explorer, select the TempConvert1 project.

2. On the Project menu, click Copy Project.

3. In the Destination project folder box, enter the desired location to copy the project.

4. Click either FrontPage or File share to select a Web access method.

5. Click Only files needed to run this application.

6. Click OK.

8. Web Server 

eg of Java Web server: Apache, Tomcat, Weblogic, WebShere, Oracle 9iAS

Microsoft Web Server: IIS

Handling of SOAP message by Web server :  to support soap and hence web services, web server must have soap listener, the job of listener is to call the web service and return result as SOAP message( the work of marshalling/unmarshalling in RPC)

Don’t confuse that SOAP message will come to the browser, the browser is capable of displaying HTML only, there will be SOAP processor in the web server which is hosting the web server(A).
Client Application
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9.Accessing an XML Web Service Using  Visual C#.net

1.Creating an XML Web Service Client Project

First we create a simple Web application that accesses the TempConvert1 XML Web service.

To create an ASP.NET Web application
1. On the File menu, point to New, and then click Project to open the New Project dialog box.

2. Expand the Visual C# Projects folder.

3. Click the ASP.NET Web Application icon.

4. Enter the address of the Web server on which we will develop the Web application and specify TempConvertClient1 as the directory name, such as "http://MyServer/TempConvertClient1". By default, the project uses our local machine, "http://localhost".

5. Click OK to create the project.

6. From the Web Forms tab of the Toolbox, drag a Text Box, a Label, and a Button to the design surface of WebForm1.aspx and arrange them to our liking.

7. Right-click the button we added, Button1, and click Properties on the shortcut menu. In the Properties window, set the Text property to Convert.

8. Right-click the label you added, Label1, and click Properties on the shortcut menu. In the Properties window, clear the Text property to make this a blank label.

2. Adding a Web Reference

XML Web service discovery is the process by which a client locates an XML Web service and obtains its service description. The process of XML Web service discovery in Visual Studio involves interrogating a Web site following a predetermined algorithm. The goal of the process is to locate the service description, which is an XML document that uses the Web Services Description Language (WSDL).

The service description describes what services are available and how to interact with those services. Without a service description, it is impossible to programmatically interact with an XML Web service.
Your application must have a means to communicate with the XML Web service and to locate it at run time. Adding a Web reference to your project for the XML Web service does this by generating a proxy class that interfaces with the XML Web service and provides a local representation of the XML Web service.

To add a Web reference
1. On the Project menu, click Add Web Reference.

2. In the URL box of the Add Web Reference dialog box, type the URL to obtain the service description of the XML Web service we want to access, such as http://localhost/TempConvert1/Service1.asmx. Then click the Go button to retrieve information about the XML Web service.

3. In the Web reference name box, rename the Web reference to ConvertSvc, which is the namespace you will use for this Web reference.

4. Click Add Reference to add a Web reference for the target XML Web service.

3. Accessing the XML Web Service

Once we add a reference for the XML Web service to our project, the next step is to create an instance of the XML Web service's proxy class. We can then access the methods of the XML Web service in the same manner that we access any object's methods by calling methods in the proxy class. When our application calls these methods, the proxy class code generated by Visual Studio handles the communications between our application and the XML Web service.

First, we will create an instance of the XML Web service's proxy class. Next, we will take a value, provided in TextBox1, and make a call to the XML Web service's ConvertTemperature method using the proxy class. We will then display the value returned from the XML Web service in Label1.

To access the XML Web service
1. Double-click the Convert button on WebForm1.aspx to create an event-handling method for this button and to display the code-behind file.

2. Enter the following code

// C#

protected void Button1_Click (System.Object sender, System.EventArgs e)

{

try

{

ConvertSvc.Service1 ws = new ConvertSvc.Service1();

double dFahrenheit = Convert.ToDouble(TextBox1.Text);

double dCelsius = ws.ConvertTemperature(dFahrenheit);

Label1.Text = dCelsius.ToString();

}

catch

{

Label1.Text = "Conversion failed.";

}

}

3. Select WebForm1.aspx in Solution Explorer.

4. On the Project menu, point to Web Project, and then click Set as Start Page.

5. Save the solution.

Conclusion

XML Web services are enabling a new era of distributed application development. It is no longer a matter of object model wars or programming language beauty contests. When systems are tightly coupled using proprietary infrastructures, it is done so at the expense of application interoperability. XML Web services deliver interoperability on an entirely new level that negates such counterproductive rivalries. As the next revolutionary advancement of the Internet, XML Web services will become the fundamental structure that links together all computing devices.
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